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BD CellQuest Pro™ Analysis Tutorial

Introduction

This tutorial guides you through a CellQuest Pro Analysis run like the one
demonstrated in the CellQuest Pro Analysis Movie on the BD FACStation™
Software CD-ROM.

This tutorial covers:

•  Analyzing data using dot plots, contour plots, and histograms
•  Creating regions and markers
•  Setting quadrants
•  Displaying and editing statistics
•  Analyzing panels

To perform the steps in this tutorial, you will need:

1. CellQuest Pro Version 4.0 or higher
2. Quick Time version 4.0 or higher

NOTE: Steps appearing in boldface are key instructions. Additional information
is provided in plain text.

In CellQuest Pro, any Experiment document you set up with plots, regions,
gates, statistics, markers, text, and colors can be saved. Data files are not saved in
the Experiment document. CellQuest Pro saves a reference to the data files that
contain the information needed to recreate the plots and stats on the Experiment
document. CellQuest Pro automatically creates a new Experiment document
named Untitled each time you launch the program by clicking the CellQuest Pro
application icon.

A. Creating an Analysis Document

1.  Choose CellQuest Pro from the Apple Menu.
An untitled Experiment document window appears.

2.  Expand the Experiment document window to full size by clicking
the zoom box in the upper-right corner of the window.
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3.  Select the Dot-Plot tool in the tool palette.
The Dot-Plot tool becomes highlighted.

4.  Click in a clear area of the Experiment window and drag diagonally
until the plot outline is the desired size; release the mouse.
The plot and the Dot Plot Inspector appear. The Inspector window
displays the attributes of a selected object or group of objects. Only one
Inspector can be displayed at a time. Items appearing in the Inspector
window can change depending on the object or group of objects
selected. When an object is active or deselected, the Inspector is empty.

5. Choose Select File from the File pop-up menu in the Inspector.
The Open a Data File dialog box appears.

6. Click in the folder pop-up menu and choose Macintosh Hard Drive;
click Open.

7.  From the Hard Drive, open the BD Applications folder, then the
CellQuest Pro Folder; open the Sample Files folder.

8.  Select the isotype control data file, NORM001; click Open.

Dot-Plot tool

Open a Data File
dialog
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9.  Change the color of the dots displayed by clicking on the white
rectangle next to Event Color in the Inspector.
Choose a different color from the Color Palette that appears.

10. Click the Multicolor Gating box in the Inspector to select it.
A checkmark appears in the box.

11.  Click and drag the frame of the plot and move it away from the tool
palette.
You have just selected the plot and moved it. When a plot or any view
is selected, black handles appear on each corner. Selected objects are
affected by any command. Only selected views can be resized, deleted,
and moved.

B. Defining a Lymphocyte Gate

Analyze a data subpopulation by drawing a region around the cells of
interest. In this case, you want to analyze lymphocytes only. The FSC vs
SSC isotype control dot plot contains lymphocytes, monocytes, and
granulocytes. In order to analyze the lymphocytes, you must first draw a
region around the lymphocytes.

1.  Click the Snap-To tool in the tool palette to select it.
The tool becomes highlighted.

2.  Click on the lymphocyte population in the FSC vs SSC plot.
A region is automatically drawn around the lymphocytes. To resize the
region, click once anywhere on the region outline to select  it. Click on
one of square handles and drag to reposition the vertex. Do not click
inside the region, as this deselects it.

To adjust the individual vertices, double-click anywhere on the region
outline. Individual vertices appear. Click on one of the square handles
and drag to reposition the vertex.

Snap-To–tool
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To delete the region, make sure the region is selected (the square
handles are visible) and press Delete or choose Cut from the Edit
menu.

For more information on editing, moving, hiding, or deleting regions,
refer to your CellQuest Pro software manual.

Once drawn, the region created with the Snap-To tool behaves like any polygon
region, except it has the ability to redraw itself when a new data file is read into
the plot in which it was created. For more information about the Snap-To tool,
consult the CellQuest Pro software manual.

OPTIONAL
Practice creating another region type by following the steps below.

1.  Click the Polygon-Region tool in the tool palette to select it.

2.  Click on the FSC vs SSC plot to set the first vertex of the polygon region
around the monocytes.

3.  Move the cursor to the next location and click again to draw the next
vertex.
Continue the process until the monocyte region is surrounded and the first
vertex has been reached. Once the first and the last vertex meet, the region
is complete. R2 appears since this is the second region drawn.

Polygon-Region tool
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4.  Practice adjusting the region.

5. Practice using the Highlight features.
To highlight a population, choose Gate List from the Gates menu. Click the
G1 or G2 Hilite box in the Gate List. View the dot plot to see the change.

You can highlight up to sixteen populations. The highlight feature increases
the size of events displayed in the plots, making them more prominent and
easier to view. Highlighting does not add events or affect statistics. With
this feature, you can create plots highlighting populations of interest for
analysis and publication purposes.

6. Press  the Option key and click in the plot.
The region show/hide pop-up menu appears.

7. Select Hide All Regions.
The regions disappear from the plot.

8. Select Show All Regions from the Show/Hide pop-up menu.
The regions reappear on the plot.

9. Without the Option key pressed, click on the R2 region outline to select
the region.

10.  Press Delete.
The region disappears from the Region List and from the dot plot. The
region is now deleted from the document.
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C. Creating an FL1 vs FL2 Contour Plot

Now you will view the gated subclass control data on a fluorescence plot.

1.  Choose Contour Plot from the Plots menu.
A contour plot appears, along with the Inspector.

2.  Choose Select File from the File pop-up menu in the Inspector.

3.  Open data file NORM001.
The default folder should be the Sample Files folder. If it isn't, follow
the same pathway as described in steps 5 through 8 in Section B.

4.  Choose FL1 from the X parameter pop-up menu and FL2 from the Y
parameter pop-up menu in the Inspector.

5.  Choose G1=R1 from the Gate pop-up menu.

6.  Choose Log Density from the Scale pop-up menu.

7.  Change the contour color by clicking on the white rectangle next to
Color in the Inspector; choose a different color from the Color Palette
that appears.

8.  Click the frame of the plot and drag it to a clear area of the
Experiment window.

D. Defining Quadrant Markers and Displaying Statistics

You will set quadrant markers around the gated data in the FL1 vs FL2
contour plot. The subclass control acts as a negative control in
immunophenotyping. Set quadrant markers using this sample to designate
the areas of negativity and positivity on the plot.

1.  Select the Quadrant Marker tool in the tool palette.
The tool becomes highlighted.

Quadrant Marker tool
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2.  Click the FL1 vs FL2 plot and drag the handle of the markers so that
the isotype control is in the lower-left quadrant. Release the mouse
to set the quadrants.
To change the position of the markers, click the handle at their
intersection point and drag the markers to a new location. You can also
delete the marker when it is selected. Click the plot outside the
markers to deselect them and the handle disappears. Note that when
you click on the contour plot, the frame turns gray, which means that
the plot is active. To activate a plot or any view, click anywhere in the
view except on the frame. Only one view can be active at a time and
any command affects only that view.

3.  Choose Quadrant Stats from the Stats menu.
The quadrant statistics view appears with descriptive and statistical
information.

4.  Click the Quadrant statistics view and choose Edit Quadrant Stats
from the Stats menu.
Deselect all choices except the File Name, Quadrant Label, Percent of
Gated, and Percent of Total. Also choose One Column in the Header
Columns field.

5.  Click OK in the Edit Quadrant Statistics view.

6.  Click the border of the stats view and decrease the size. Move the
stats box underneath or next to the FL1 vs FL2 plot.
Editing the stats view and decreasing its size allow for more room on
the Experiment document.

E. Creating an Analysis Histogram Plot

1.  Select the Histogram-Plot tool from the tool palette.
The Histogram tool becomes highlighted.

Histogram-Plot tool
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2.  Click in a clear area of the Experiment window and drag diagonally
until the plot outline is the desired size.

3.  Choose Select File from the File pop-up menu.
The Open a Data File dialog box appears.

4.  Open NORM001.
The default folder should be the Sample Files folder. If it isn't, follow
the same pathway as described in steps 5 through 8 in Section B of this
tutorial.

5.  Choose FL1 as the X Parameter.

6.  Choose G1=R1 from the Gate pop-up menu.

7.  Change the Line and Fill colors by clicking in the rectangle next to
Line and Fill.
Choose different Line and Fill colors.

OPTIONAL
If you want to make all the plots the same size, follow these steps.

1. Select all the plots.
Press the Shift key and click on the border of each plot. Square handles
appear at the corners of all plots.

2. Enter 3.0 in the Width box; then enter 3.0 in the Height box under
Geometry in the Inspector.

3. After entering 3.0 in the Height box, press the Tab key to accept the entry.
All plots are now the same size.

4. Readjust the position of the plots so they are not overlapping, if
necessary.

F. Defining Histogram Markers and Displaying Statistics

CellQuest Pro calculates statistics for the entire histogram or for sections of
the histogram. Sections are defined by setting histogram markers. A marker
consists of an upper and lower boundary connected by a horizontal line. A
marker generates statistics for the events in a designated section of the
histogram.
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1.  Select the Histogram-Marker tool from the tool palette.
The tool becomes highlighted.

2.  Set the marker around the negative control population (Figure 1).
Click to position the left edge of the marker and drag to position the
right edge of the marker. Release the mouse button to complete the
marker. As the cursor passes over the plot, its shape changes to a
crosshair to indicate that you can define histogram markers. The
ribbon under the title bar displays the channel number or linear value
(X axis) and the count (Y axis).

The marker appears with a handle at each endpoint.

3.  Repeat steps 1 and 2 to draw another marker from the upper
boundary of marker 1 to the end of the histogram plot (Figure 1).
Any population inside marker M2 is positive for FL1 (Gamma-1).

Figure 1

4.  Select the histogram plot.

5.  Choose Histogram Stats from the Stats menu.
The Histogram Statistics view appears. Notice that the stats view
editing and size is retained from the last stats view edited (in this case
the Contour Plot Stats view).

Histogram-Marker
tool



11-11048-00 10

6.  Click the border of the Histogram statistics view and position the
view underneath the histogram plot.

7.  Print one copy of the document by selecting Print One from the File
menu.
The Printer dialog box is bypassed and one copy of the Experiment
document is printed.

8. Look at the Analysis view of the browser.
If the view is hidden behind the experiment window, choose
Browser:untitled from the Windows menu.

Click the disclosure triangle next to the folder icon and the tube icon to
view all the items in the analysis browser.

Notice that the view now displays the subclass tube, and the three
plots currently displaying the data file from the tube are listed under
the tube’s icon.

G. Saving an Experiment Document

You can save an Experiment document you have set up with plots, gates,
markers, and statistics. The document can be opened later to resume your
analysis or acquisition, or it can be used as a template for analyzing or
acquiring future samples.

1.  Choose Save from the File menu.
The Save dialog box appears.

2.  Click the folder pop-up menu and select Desktop.

3.  Click the New Folder button and create a folder in which to save the
Experiment document.
Enter a folder name in the dialog box that appears;  click the Create
button.
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4. Enter Analysis 1 as the name for your Experiment document.

5. Click Save.

H. Batch Analyzing the Remaining Files in the Panel

Once you have set up the Experiment document with plots, gates, markers
and statistics, CellQuest Pro can analyze subsequent files by batch. The
Batch analysis feature is based on the Next File command. For selected plots
in the active Experiment document, batch analysis will call the Next File
command repeatedly until the plots can no longer advance to the next file in
the folder. In addition to advancing data files for the plots, batch analysis
can automatically pause after each execution for you to adjust markers or
regions while the batch is paused. Batch analysis can also provide automatic
printing of the document after each execution of the Next File command
and automatic appending of statistics to an export file. For more
information regarding batch analysis, refer to the latest version of your
CellQuest Pro software manual.

1.  Choose Setup from the Batch menu.
The Batch Setup dialog box appears.

2.  Click the All radio button in the Plots and Stats to Process field.
All plots in the document will be selected each time the Next File
command is executed.

3.  Click the for [n] seconds radio button in the Pause after each file
increment field and change the pause time to 3 seconds.
The batch will pause for three seconds after each execution of the Next
File command.

4.  Click in the Print after each file increment checkbox.
The Print One command is executed after each Next File command.
Printing will occur after the three-second pause.

5.  Set the File Increment to 1; then click OK.

6.  Choose Run from the Batch Menu.
Batch processing automatically starts and the Batch control floater
appears. The floater has buttons in it that allow you to manually
control batch analysis. Refer to the CellQuest Pro software manual for
more information about the Batch control floater.

Batch analysis of files in the Sample Files Folder occurs. The batch
finishes when the last plot has been analyzed. The batch floater closes
automatically when the batch finishes and a message dialog appears
stating The batch has completed. All the plots are at the end of their folders.
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7.  Click OK to remove the message from the screen.
Batch Analysis is complete.

I. Using the Expression Editor

To practice using the Expression Editor feature, you will calculate the
T helper-suppressor ratio.

1. Select the histogram plot and delete it.
To delete the plot, choose Clear from the Edit menu or press Delete on
the keyboard.

2. Select all the plots.
NOTE: Do not select the statistic views.

3. Choose Select File from the File pop-up menu in the Inspector.

4. Go to the Sample Files folder in the CellQuest Pro folder and open
data file NORM003.
This is the CD3/CD4 data file.

5. Select the FL1 vs FL2 plot.

6.  Choose Duplicate from the Edit menu.

7. Move the new plot to a clear area in the Experiment document
window.

8. Display data file NORM004 in the new plot.
This is the CD3/CD8 data file.

9. Display quadrant stats for the new plot.
To display the stats, make sure the plot is selected or active; choose
Quadrant Stats from the Stats menu.

10. Click the Expression Editor tool on the tool palette. See Figure 2.
The Expression Editor dialog box appears. You can also access the
dialog box by choosing New Expression or Edit Expression from the
Stats menu.
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Figure 2

11. Enter Helper/Suppressor in the Label field.

12. Make sure the mouse cursor is in the expression box; click the %
Gated number for the upper-right (UR) quadrant in the Quadrant
Statistics view for NORM003. See Figure 3.
The UR %Gated number is the %CD3+CD4+ T-helper cell population.

Figure 3

13. Click the  button in the editor window.

14. Click the % Gated number for the upper-right (UR) quadrant in the
Quadrant Statistics view for NORM004.
The UR % Gated number is the %CD3+CD8+ T-suppressor cell
population. The calculated result is shown in the editor.

Expression Editor
tool

expression box

click on the
UR % Gated
number
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Note: The numbers you have might be different from these shown in
the example.

15. Click in the Suffix box and enter T H/S Normal Range is 0.8 to 4.2.
This is an example of a suffix.

16. Click Apply.
The expression editor window disappears and the label and calculated
result appear in the Experiment document view area.

17. Move the result to a clear area of the document.

18. Change the font type, size, or style, if you want.
To make changes to the font, make sure the text is selected and enter
changes in the Inspector. Use the square handles to resize the text area,
if you want.

J. Using the Load Sample Feature

To practice using the Load Sample feature, you will analyze a series of
samples in the Sample Files folder. First, you will set up the analysis
document.

1. Select the two plots currently displaying data file NORM003.
To select both plots at the same time, click in the border of one plot;
then hold down the shift key and click on the border of the second
plot. Both plots should have handles on them to indicate that they are
selected.

calculated
result
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2. Choose Select File from the File pop-up menu in the Inspector.

3. Navigate to the Sample Files folder and open data file NORM001.
NORM001 is displayed in both plots.

4. Choose Document Size from the File menu.
The Document Size dialog box appears.

5. Click the square next to the highlighted square and click OK.
The document is now two pages.

6. Create three additional FL1 vs FL2 dot plots gated on G1=R1 and
display data files NORM002, NORM003, and NORM004 in the plots.

7. Copy the quadrant markers from the plot displaying data file
NORM001 and paste the markers on the new plots.

8. Display quadrant statistics for the new plots.

Your Experiment document should now contain 5 plots. The Sample Files
folder contains twelve data files. The data files are from three different
donors. Each donor sample was stained with the four-tube reagent panel
listed below.

Tube 1 Gamma 1 FITC/Gamma 2a PE
Tube 2 CD3 FITC/CD19 PE
Tube 3 CD3 FITC/CD4 PE
Tube 4 CD3 FITC/CD8 PE

The Load Sample feature helps you manage the analysis of panels. To see
the power of this feature, you will temporarily remove a few of the data
files to see how it can handle missing files from a panel.

1. Drag data files NORM006 and NORM011 from the Sample Files Folder
to the Desktop.
Go to the hard drive icon and double-click it. Go to the BD Applications
folder and open it. Open the CellQuest Pro Folder. Open the Sample Files
folder. Drag the NORM006 and NORM0011 data files to the desktop.

2. Open the Browser if it is not already opened and click on the Analysis
Tab.
To open the Browser, choose Show Browser from the Windows menu.
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3.  Choose Load Sample from the Analysis Browser pop-up.

4. Choose NORM005 in the Load Sample dialog box.

5. Click Load sample.

6. View the Browser and the Experiment document window.

missing file
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In the Experiment document, Data files NORM005, NORM007, and
NORM008 are displayed in the plots. Notice that one plot is empty. This
plot previously displayed data from a CD3/CD19 tube in the panel. Even
though the data file for the CD3/CD19 tube is missing (NORM006),
CellQuest Pro is still able to display the data from the other tubes in the
panel.

7. Choose Print, if you want.

8. Choose Next Sample from the Analysis Browser pop-up.

9. View the Experiment document.
Data files NORM009, NORM0010, and NORM0012 are displayed in the
plots. Notice that one plot is empty. This plot previously displayed data
from a CD3/CD4 tube in the panel. Even though the data file for the
CD3/CD4 tube was missing (NORM0011), CellQuest Pro was still able to
display the data from the other tubes in the panel that were present.

10. Choose Print, if you want.

11. In the Analysis view of the browser, press Option and click on one of
the plots.
The experiment document view moves to the location of the selected plot.
You can use the Analysis view of the browser to help you navigate to
different parts of the experiment document in this way.

12. Choose Save As from the File menu and enter Analysis 2 as the file
name.

13. Choose the folder where Analysis 1 was saved and click Save.

14. Drag NORM006 and NORM011 back into the Sample Files folder in the
CellQuest Pro Folder.

K. Exporting Graphics

Follow the steps below to practice using the graphics export features.

1. Select the FSC vs SSC plot.
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2. Choose Export Graphic from the File menu.
The export graphic dialog box appears.

3. Type a name for the file or leave the default name.

4. Choose the type from the Type pop-up menu.
Choose from JPEG, BMP, PNG, or PICT.

5. If JPEG was selected in step 4, click Options and make selections in
the JPEG options window. Click OK.

6. Choose the background color for the plot from the Background
pop-up menu.

7. For this example, choose the Desktop as the export destination.

8. Click Save.

You have completed the CellQuest Pro Analysis Tutorial. Now you are ready to
analyze your own data files.


